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Excel 3: Linking, PivotTables, vLookup, & 

Macros Class Guide 
Instructor: Susan Jerger  

 

Part 1: PivotTables 
1.1 PivotTable Basics 
 PivotTable = A feature that enables you to summarize and analyze data in lists and tables. Pivot 
tables are called such because you can quickly rearrange the position of pivot table fields to give you 
a different view of the table (from http://www.cs.rtu.lv/PharePub/Microsoft%20Access%2097%20Quick%20Reference/htm/ch09.htm). 

 
Exercise 1: Use the PivotTableData worksheet in the Excel3ClassSpreadsheets 
workbook 

 Place the cell pointer somewhere in the sales table. 

 Click on Insert on the Ribbon and then choose PivotTablePivotTable. 

 The Create PivotTable window pops up.  Verify that the Range is correct 
and click OK and you will be taken to a new worksheet for your PivotTable. 

 The PivotTable Field List should appear on the right.  Choose Region (as 
Rows) and Sales Total (as Values). Sales Totals may default 
to Count.  Should this happen, in the Values box, left click on 
Count of Sales.  Then choose Value Field Settings. Click on 
Sum and OK. 

 Left click on Sum of Sales in the bottom right.  Click on 
Value Field Settings and then Number Format at the bottom 
of that box.  Format this field as Currency and do OK twice to 
return. 

 Take out Region and add in Salesperson.  Change value to the Max 
of Sales Total.  If you ever click off of the PivotTable, you can always get 
the PivotTable Tools tabs to appear by clicking back on the table. 

 If you update data in your data range, you may need to Refresh your 
PivotTable by clicking on Refresh on the PivotTable ToolsOptions tab. 
 
NOTE: Consider making your PivotTable data into a “Table” [highlight 
data area including header row  click Insert tab Table  OK] in case 
you add additional rows of data later on. 
 

Part 2: True Tables 
2.1 Format as Table 
  To make life easier you can official mark you table as a table in Excel. This will help down the road 
if you add in new rows, delete columns, etc…you won’t have to worry as much about changing cell 
references. 
 
Exercise 2: Use the PivotTableData worksheet  

 Click somewhere between Cell A3 and D68. 

 On the Home tab, click Format as Table. 

 Choose a color scheme and then verify that your entire table area is selected. Click OK. 

  

http://www.cs.rtu.lv/PharePub/Microsoft%20Access%2097%20Quick%20Reference/htm/ch09.htm
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Part 3: vLOOKUP Function 
3.1 vLOOKUP 
   The “v” in vLOOKUP stands for vertical.  You can use this function to look up a value in a predefined 
range and return a corresponding value.  Here is the syntax: 
 

=vlookup(lookup_value,table_array,col_index_num,[rangle_lookup]) 
 

From http://office.microsoft.com/en-us/excel-help/vlookup-function-HP010343011.aspx: 
 
lookup_value – Required. The value to search in the first column of the table or range. 
The lookup_value argument can be a value or a reference. If the value you supply for the 
lookup_value argument is smaller than the smallest value in the first column of 
the table_array argument, VLOOKUP returns the #N/A error value.  
 
table_array – Required. The range of cells that contains the data. You can use a reference to a range 
(for example, A2:D8), or a range name. The values in the first column of table_array are the values 
searched bylookup_value. These values can be text, numbers, or logical values. Uppercase and 
lowercase text are equivalent. 
 
col_index_num - Required. The column number in the table_array argument from which the 
matching value must be returned. A col_index_num argument of 1 returns the value in the first 
column in table_array; acol_index_num of 2 returns the value in the second column in table_array, 
and so on. 
 
range_lookup – Optional. A logical value that specifies whether you want VLOOKUP to find an exact 
match (FALSE) or an approximate match (TRUE): 

If range_lookup is either TRUE or is omitted, an exact or approximate match is returned. If an 
exact match is not found, the next largest value that is less than lookup_value is returned. This 
works best if values are in ascending order. 

 
Exercise 3: On the vLookup spreadsheet in the Excel3ClassSpreadsheets workbook… 

 Go to B3 and use the =max() function to determine the maximum share price (cells A7-A42) 
o Adjust formatting to a number with 5 decimal places. 

 Go to B4 and use the vlookup function to return the maximum share price’s date:  

=vlookup(B3,A7:B42,2,FALSE) 
 Format B4 for short date if it’s not already set that way. 

 
Exercise 4: Still on the vLookup spreadsheet… 
Say you don’t really care about having the maximum price listed at the top…you only care about 
seeing the max price DATE.  How can you get rid of row 3?  Hint: You can nest functions inside of 
each other but only use 1 “=”. 

 
 
 
SPOILER ALERT! (with the old Row 3 cleared) 

http://office.microsoft.com/en-us/excel-help/vlookup-function-HP010343011.aspx
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=vlookup(max(a7:a42),A7:B42,2,FALSE) 
 
NOTE: if your data is set-up horizontally you can use the HLOOKUP function. 
 
 

Part 4: Name That Cell/Those Cells 
4.1 Naming 
   You can name a cell or a group of cells in your spreadsheet which can facilitate using functions. 
 
Exercise 5: On the vLookup spreadsheet... 

 Highlight A7 to A42. 

 Go to the Name box (to the left of the Formula Bar) and type SharePrices. 

 Now change the function reference for A7:A42 to SharePrices. 
  

Not sure what’s been named on a spreadsheet?  You can see on the named areas by going to the 
Formulas tab and clicking on Name Manager. 
 
NOTE: Keep in mind you can also offically name Tables! (highlight range, Insert tabTable) 

 
 
Part 5: Manipulating Sheets 
5.1 Inserting, Renaming, and Linking  
Insert a Sheet 

 Click on InsertInsert Sheet (you can click and 
drag worksheets into whatever order you prefer).  
 OR click on the Insert Sheet button near the tabs 
at the bottom 

Renaming Sheets 
  You can change the generic sheet names “Sheet1, Sheet2, etc.” to something more meaningful: 

 Right-clicking on the current sheet name.   
 Select Rename. 
 Type in the new name and hit Enter. 

Moving Sheets 
  You can easily rearrange your sheets by clicking & dragging the sheet tab to the desired location 
Link Sheets 
  It can be helpful to connect different sheets in order to perform calculations or compare data 

 Click on the blank cell you want to link. 

 Type = and click on the worksheet that has the cell you want to copy. 

 Click on the cell you want to link and press Enter. 
Toggling Between Sheets 
  Since you can have numerous sheets it can sometimes be hard to view the tabs all at once or just to 
get to the next one in line.  You can toggle using the keyboard shortcuts:  CTRL+Page Up and 
CTRL+Page Down. 
 
Exercise 6: Open the Salesfor2008.xlsx workbook file for this exercise. 

 Insert a new worksheet and rename it 1st Quarter Sales 

 Reorder the worksheets so that they are in chronological order but with 1st Quarter Sales first. 

 Create the table below on the new sheet: 
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 Link the sales figures for each month into the correct cell on the 1st Quarter Sales sheet.  

For instance: 1. Click on 1st Quarter Sales’ cell B4 and type =.  Go 

to January’s sheet and click on Cell B4 and press Enter. Do 
Autofill to copy and paste the linking formula for the other colors 
(use the Autofill dropdown arrow to choose Fill Without 
Formatting). 

2. Click on 1st Quarter Sales’ cell C4 and type =.  Go 

to February’s sheet and click on cell B4 and press Enter. 

 Use AutoSum to tally all the color totals and all the monthly totals for the quarter.  When 
you’re all finished, it should look something like this: 

 

 
 
 
 
 
 
Part 6: Find & Replace Almost Anything 
6.1 Find and Replace 
  You can pull up the Find and Replace window in Excel by typing CTRL+F.  Can’t remember where 
you typed something?  Do a Find for it within a worksheet or the entire workbook.  Need to replace 
some information?  Do a Find and Replace (again within the worksheet or the entire workbook). 
 
Exercise 7: Still in the Salesfor2008 file… 

 Type CTRL+F and click on the 
Replace tab 

 Find all the instances of the word 
Brown and Replace them with the 
word Gold. 

 Save the file. 
Note: You can also access Find and Replace 
from Find & Select on the right side of the 
Home tab. 
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Part 7: Macros 
7.1 Creating a Macro 
  A macro is a recording of tasks…a way to automate repetitive tasks in your workbook.  Excel macros 
are written in Excel VBA (Visual Basic for Applications).  For simple macros you don’t actually need to 
know Excel VBA. 
 
Since macros involve coding, a file with macros need to be saved as “Excel Macro-Enabled Workbook” 
for the macros to work later on. 
 
And, also since macros involve coding, they can be used to spread malicious codes so only run macros 
from people you trust. 
 
The macro tools are on the Developer tab which doesn’t always show up by default in Excel 2010.  To 
see it, click on File  Options  Customize Ribbon  check Developer on the right.  Click OK. 
 
Exercise 8: Still in the SalesFor2008 workbook 
We are going to create a macro to automatically 
put in a line of text at the top of a sheet. 

 Go to the 1st Quarter Sales sheet.  

 Click the Developer tab. 

 Click Record Macro. On the Record 
Macro window, type in the name 
InsertTitle.  Make “t” the shortcut key 
(you are not required to insert a 
shortcut). 

 Click OK. 

 Right-click on Row 1. 

 Left-click and choose Insert. 

 Click on cell A1 and type in the 
following: 
 

Widgets r Us, Inc. 

 

  Type Enter. 

  Click on Developer tab if not already there. 

 Click Stop Recording. 

 Run this macro on the other sheets in the workbook using the keyboard shortcut or by going to 
the Developer tab, click Macros, choose InsertTitle, and click Run. 

 Do Save As and save this file as an Excel Macro-Enabled Workbook so the macro will work in 
the future. 

 
 

Part 8: Further Help 
8.1 HELP!    

Excel has a help feature that can aid you in refreshing your memory on certain tasks or by 
even learning new tasks.  Help can be reached at by clicking the Question mark in the upper 
right hand corner.  You will most likely be directed to Office.com’s online help, but there is an 

offline version if needed.  



Excel 3 v.7.2                       Greenwood Public Library  

www.greenwoodlibrary.us 6 

 
8.2 Additional Help 

  Below are some websites that might be of help to you: 
 
www.greenwoodlibrary.us/computer-class - Lists all of the library’s computer classes and includes the 
Excel guides and class spreadsheets. 

www.inspire.in.gov - Click on the Testing & Education button near the middle of the page (then click 
on Career Tools and then Basic Computer Skills—you will need to create a free account)  

www.gcflearnfree.org - A great collection of tutorials on a wide array of subjects including Microsoft 
Excel 2007, 2010, and 2013. 

www.free-training-tutorial.com   

http://spreadsheets.about.com/ 

www.customguide.com/cheat-sheets/ - Free cheat sheets for most Office programs. 

www.google.com/work/apps/business/products/sheets/ - You can use Google Sheets for free (after 
creating a Google account) to practice many of the Excel features we’ve used today. 

You can also find help by searching for the function you want to use or the problem you’re having 
using your favorite search engine. 

 

Thank you for coming! 
Please fill out a Computer Class Survey before leaving. 
http://www.greenwoodlibrary.us/programming-survey 

(or go to www.greenwoodlibrary.us Services & Programs  Computer Survey) 
 

Instructor’s Name: Susan    Class: Excel 3 
 
 

__________________________IF THERE’S EXTRA TIME!____________________________ 
 

SumIf Function 
  SumIF is a function that allows you to test criteria before adding cells together.   
 
Exercise:     

 Open SumIfExercise workbook. 

 Turn the table of information into an “official” table and name it Expenses. 

 Go to cell B3. 

 Type in the SumIf function: 

=sumif(C$10:C$25,A3,D$10:D$25) 
or =sumif(Expenses[Category],A3,Expenses[Amount]) 

 

 Use Autofill to calculate the expense categories. 

http://www.greenwoodlibrary.us/computer-class
http://www.inspire.in.gov/
http://www.gcflearnfree.org/
http://www.free-training-tutorial.com/
http://spreadsheets.about.com/
http://www.customguide.com/cheat-sheets/
http://www.google.com/work/apps/business/products/sheets/
http://www.greenwoodlibrary.us/programming-survey
http://www.greenwoodlibrary.us/

